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PRACTICA 0: Captura y simulacién de circuitos
digitales

El objetivo de esta primera practica es la toma de contacto con las
herramientas de captura y simulacién de circuitos digitales que se utilizaran para
la realizacién de las practicas de que consta esta parte de la asignatura.

La practica consistira en comprobar el funcionamiento de varias puertas
basicas (NOT, AND, OR y NAND). A lo largo de este guion se iran indicando
todos los pasos a seguir para poder simular el funcionamiento de un circuito
digital.

El proceso de realizacion de una practica constard habitualmente de tres
fases:

e Diseflo del circuito.
e Captura del esquema del circuito.
e Simulacion del circuito.

El alumno deberd realizar la primera fase antes del turno de laboratorio que
le corresponda, y solo las otras dos en el propio laboratorio. En esta primera
practica no serd necesario hacer un disefio sobre el papel, previo a la captura,
debido a su sencillez. Nos limitaremos a explicar el uso de la herramienta
Integrated System Environment (ISE) de Xilinx, que es la aplicacion que vamos
a utilizar para la realizacion de estas préacticas, y que permiten llevar a cabo las
dos ultimas fases.

El circuito que vamos a capturar y simular corresponde al que se muestra en
el disefio 1. Como puede verse, consta de dos entradas A y B, y cuatro salidas,
salida_NOT, salida_AND, salida OR y salida NAND. Para comprobar el
funcionamiento de estas puertas se tendran que generar todas las
combinaciones posibles de las variables de entrada y visualizar el valor de la
salida para cada una de las funciones. Estos valores deben coincidir con la tabla
de verdad de las funciones.
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A >c salida_NOT
} salida_AND
B

‘\ salida_OR
‘_
307 salida NAND

Disefio 1: Puertas légicas simples

1. Captura del esquema del circuito

Para poder proceder a su simulacion, en primer lugar hemos de capturar el
esquema del circuito. Es decir, realizar una representacion grafica del disefio
mediante componentes (como las puertas ldgicas), conexiones entre ellos y
entradas y salidas. Para ello tendremos que arrancar la herramienta Xilinx ISE y
crear un nuevo proyecto. Un proyecto es un conjunto de ficheros de disefio,
tales como esquematicos, listas de conexionado, librerias de componentes,
vectores de test para la simulacion, etc., seleccionados para un disefio
especifico.

1.1Ejecutar la aplicacion

Para abrir el entorno de Xilinx ISE, pulsar el icono del escritorio,

Xilinx ISE 9.1i.Ink

o arrancar la aplicacién desde el menu Inicio seleccionando:

Inicio = Programas - Electrénica 2> Xilinx ISE 9.1i - Project Navigator
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Nos aparecera una ventana como la que se muestra en la Figura 1.

= Xilinx - ISE
Elle Edit Wiew Project Source Process Window Help

iDAES LidDEX e RIPPHAP R [AiRE DDA R i@ ~:Q
(E SN

No project is open

Select
File->0pen Project
o

"
File->Mew Praoject

B¢ Sources JﬁSnapshols “ [y Libraries I

No flow available.

= Pracesses

i< I B
& (5] concle | @Fnors | _p\ warmings I@ Tt shell | [gg Findin Fiss |

CAPS | MUM | SCRL |

Figura 1: Ventana inicial de Xilinx ISE
La ventana tiene un total de cuatro ventanas secundarias:

La ventana superior izquierda es la ventana de fuentes, que presenta la
organizacion jerarquica de los elementos incluidos en el proyecto. Esta ventana
tiene a su vez tres pestafias que permiten ver los médulos funcionales (Sources),
las bibliotecas de modulos (Libraries) o varias instantaneas del proyecto
(Snapshots).

La ventana inferior izquierda es la ventana de procesos, que presenta las
distintas operaciones que se pueden realizar sobre el objeto seleccionado en la
ventana de fuentes.

La ventana inferior es la ventana de mensajes, donde se muestran distintos
mensajes del proceso que se esté ejecutando.
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La ventana de la derecha es la ventana para la edicion de los distintos ficheros
fuentes. Es una interfaz de mdultiples documentos (MDI) conocida como espacio
de trabajo (workspace), y permite ver informes HTML, documentos ASCII (como
cbdigo de descripcion de hardware VHDL), esquematicos, diagramas de estados,
simulaciones, etc.

Cada ventana puede ser redimensionada, “despegada” de su ubicacion original, o
movida a una nueva ubicacién. Para restaurar la configuracion de ventanas por
defecto seleccionamos View - Restore Default Layout.

1.2Acceso ala ayuda

En cualquier momento podemos acceder a la ayuda para consultar informacion
adicional acerca del software ISE. El acceso realizar de dos formas:

e Presionamos F1 para acceder a la documentacion de una herramienta o
funcién especifica que hayamos seleccionado o resaltado.

e Lanzamos los contenidos generales de la ayuda desde el menu Help.
Contiene informacion acerca de la creacién y mantenimiento de nuestro
flujo de disefio en ISE.

File Edit Wiew Project Source Process ‘Window I!!!

DPERS i B x| @ g Help Topics
i @ El %rt E’t a E—rt Software Manuals
3 X

Hilinx an the Web [

Tutorials 3

Update Software Product Configuration..,
Select: Tip of the Day

File->0pen Project ‘WebUpdate...

No project is open

or
File->Mew Project Aabout...

Figura 2: Ventana de ayuda en el ISE

1.3Creacién de un nuevo proyecto

Para crear un nuevo proyecto pulsamos File>New Project. La creacién de un
nuevo proyecto necesita que introduzcamos 3 tipos de datos:

¢ Datos del proyecto.

o Datos del dispositivo donde se va a implementar.
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¢ Ficheros fuente del proyecto

En primer lugar, nos aparecerd una ventana como la de la Figura 3, donde
debemos insertar los datos del proyecto.

ES New Project Wizard - Create Mew Project

Enter a Mame and Location for the Project
Project Mame: Project Location

practica1| C:hhlocalypractical E]

Select the Type of Top-Lewvel Source for the Project

Top-Level Source Type:

Schematic v
< Back [ Mest > l ’ Cancel

Figura 3: Datos del proyecto

1.3.1 Datos del proyecto

Project Name damos el nombre de nuestro proyecto. Por ejemplo practical.

Project Location damos el camino de datos donde se guarda el proyecto.
Aconsejamos  utilizar c:\hlocal\NombreProyecto En nuestro ejemplo
c:\hlocal\practical.

Top Level Source Type De momento sélo utilizaremos el Tipo Schematic,
aunque podrian utilizarse otros métodos de descripcion, como maquinas de
estado o lenguajes de descripcion hardware: VHDL y Verilog.
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1.3.2 Datos del dispositivo

Después pulsamos el botén de Next, lo cual da lugar a la aparicion de otra
ventana (como la de la Figura 4) que sirve para dar los datos del dispositivo sobre
el que se va a realizar la implementacién del disefio.

En este caso hay que introducir los datos de la familia de FPGAs con la que
vamos a trabajar (Spartan 2, Spartan 3, Virtex, etc), los datos del dispositivo en
particular y de su empaquetamiento. Todos estos datos pueden leerse sobre el
circuito integrado correspondiente a la FPGA que estamos usando, y para el caso
en particular de las FPGAs del laboratorio son los que se muestran en la Figura 4
(Spartan3 XC3S1000 FT256). El resto de los datos sobre las herramientas de
sintesis, simulador, etc, deben seleccionarse también como se muestra en la
misma figura.

ES New Project Wizard - Device Properties

Select the Device and Design Flaw far the Praject

Property Hame Walue |
Praduct Category All w
F amily Spartand “
Device =C351000 w
Package FT256 -
Speed R w
TopLevel Source Type Schematic

Synthesziz Tool ®5T WHDLAYenilog) w
Simulator Modelzim-<E YHOL b
Preferred Language WHOL w
Enable Enhanced Design Summary

Enable Message Filtering O

Display Incremental Messages O

(e e ] (o=

Figura 4: Datos del dispositivo y del flujo de disefio

1.3.3 Ficheros fuente del proyecto

Los ficheros fuentes del proyecto pueden ser de dos tipos:

e Ficheros nuevos, que vamos a crear en nuestro proyecto.

Laboratorio de Fundamentos de computadores



Facultad de Informética
Universidad Complutense de Madrid

Curso 2009/10

e Ficheros existentes, creados para otros proyectos y que vamos a
reutilizar en nuestro proyecto.

Volvemos a pulsar Next y nos aparece una ventana como la de la Figura 5. Esta
ventana sirve para determinar todos los ficheros fuente que vamos a crear en
nuestro proyecto. En las practicas iniciales nuestro proyecto estara formado por
un unico disefio en formato esquematico, y por tanto sélo utilizaremos un fichero
fuente. Pero en practicas mas complejas puede utilizarse disefio jerarquico,
formado por varios médulos conectados entre si, cada uno de ellos sobre un
fichero fuente diferente, e incluso en un formato distinto.

Create a New Source

Source File

Type

Exizting sources can be added on the next page.

Mew Source

Bemove

Creating a new souce to add to the project is optional. Only one new source can be created with the Mew Project 'wizard,
Additional sources can be created and added to the project by using the “Project->New Source’ command

S New Project Wizard - Create New Source g|§|@

[ ¢ Back ] I

Mext >

} [ Cancel

]

Figura 5: Datos de los nuevos ficheros fuente del proyecto

1.3.4 Ficheros nuevos de nuestro proyecto

Pulsamos New Source y damos el nombre del fichero (por ejemplo pruebal), el
camino de datos donde vamos a almacenar el disefio (se puede dejar el que sale
por defecto), y el tipo correspondiente, que en nuestro caso serd Schematic,
como se muestra en la Figura 6.
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E Mew Source Wizard - Select Source Type [:”E|g|

'{] IP [Coregen & Architecture 'Wizard)
I

‘erilng Module File name:
W] Werilog Test Fisture
e
i VHDL Modue [prucbt |
I wHDL Library Location:
WHDL Package
B J |E:\hlocal\practica1 | E]

'] ¥HDL Test Bench

Add ta project

< Back [ Mext » l [ Cancel

Figura 6: Datos de nuestro fichero fuente

Pulsamos Next y Finish.

Si el directorio no existe nos pregunta que si queremos crearlo. En este caso
diremos Yes. A continuacion nos aparece otra ventana, parecida a la de la Figura
5, pero con los datos de los ficheros fuente que hemos indicado que queremos
crear, tal y como se muestra en la Figura 7.

S New Project Wizard - Create New Source

Create a New Source

Mew Source...
Source File Type
1 pruehal.sch Schematic

Creating a new zource to add to the project iz optional. Only one new source can be created with the Mew Project \Wizard.
Additional sources can be cieated and added to the project by using the "Project-> New Source' command.

Existing sources can be added on the next page.

[ < Back ] [ Neut > ] [ Cancel ]

Figura 7: Datos de ficheros fuente nuevos que queramos crear en nuestro proyecto
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Si nuestro proyecto va a constar de mas de un modulo nuevo, repetiriamos este
proceso tantas veces como sea necesario. Cuando hayamos terminado de dar los
nombres de todos los ficheros que vamos a crear, pulsamos Next, y aparece una
ventana como la de la Figura 8, que sirve para incluir en el proyecto otros ficheros
fuente generados anteriormente. Si no vamos a incluir otros ficheros, pulsamos
Next y Finish.

1.3.5 Ficheros existentes, reutilizacién en nuestro proyecto.

El método es exactamente el mismo del proceso de crear nuevos ficheros fuente
(apartado 1.3.4), pero en este caso para afiadir disefios existentes (de otros
proyectos) tanto en formato de esquematico, como en otros lenguajes de
descripcibn como VHDL. Por ejemplo, si queremos afiadir un esquematico de
algun disefio previamente realizado, pulsaremos Add Source.

= New Project Wizard - Add Existing Sources
Add Existing Sources
Source File Copy to Project Add Source
1
Bemove

Adding existing sources is optional. Additional sources can be added after the project is created using the ''Project->Add

Source" or "Project-+Add Copy of Source'' commands.

T )(E ) (o)

Figura 8: Datos de ficheros fuente ya creados que queramos afadir al proyecto

Seleccionamos el fichero que queremos afadir (pruebal.sch) y a continuacion
Next, Finish y OK. Con esto hemos terminado el proceso de Inicializacion.

1.3.6 Apertura de un proyecto existente

Simplemente seleccionamos Archive>Open Project y seleccionamos el
proyecto que queremos abrir (con la opcion Tipo ISE Project Files) en la ventana
correspondiente (ver Figura 9).
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Open Project

©

Documentos
recientes

Ezcritorio

Mis documentos

Mis sitios dered  Mombre:

3

Buscaren: | () practical

=l & cf B

15 _xmsgs

pr:

|practicat ive

=l b

Tipg:

|15 Project Files (*ise)

j Cancelar

Figura 9: Apertura de un proyecto existente

1.4Creacién del esquemaético

Una vez terminado el proceso de inicializacién, o bien el de abrir un proyecto
existente, debe aparecer una ventana como la que se muestra en la Figura 10.
Observamos que en el workspace aparece la pestafia “Design Summary”, y que
en la ventana Sources esté seleccionada la pestafia Sources.

[ES Xilinx - ISE - C:\hlocal\practicad\practical.ise - [Design Summary]

L Fle Edit Vew Project Source Process window Help

NP HS LidREX @
AL OO

PAHAEM® BN

=TV Y Y R

Sources for:| Synthesis/Implementation v

#practical
= £ #c3s1000-51255
[l divisor - divisor_arch (divisor vhd)
[£] prueba [pruebal sch)

53 Soucss | g Srapshols

[Py Libraries

I FPGA Design Summary

= Design Dverview
Sunmary
[ 10B: Froperties
[0 Timing Constraints
[ Finout Riepart
[ Clock Repoit

= Ermars and Wamings
[ Syrtvesis Messages
) Trarslation Messages
) Map Messages —
[ Place and Rioute Messages
[ Timing Messages
[ Bitgen Messages
[21 &0 Cument Messages

=1 Detailed Renat

>

Processes for, divisar - divisor_arch
1 AddEsisting Source
1 Create Mew Soure

T View Design Summary
X Design Utiities
¥ User Constraints
P2 Sunthesize -XST
P2 Implement Design

P2 Generate Progiamming File

Project Propeities
Enable Enhanced Design Summary
O Enable Message Filering
O Display Incremental Messsages
Enhanced Design Summary Contents
Shaw Partition D ata
O Show Enors
O Show warnings
O Show Failing Constraints
O Show Clock Repart

<
2f Processes

£ Design Summary |

PRACTICA1 Project Status

Project File: mactical ise Current State: Mew

Module Name: divisor + Errors:

Target Device: #c351000-5/256 + Warnings:

Product Yersion: 1SE 9.2.03 + Updated: mar 20. nov 18:01:59 2007

PRACTICAT1 Partition Summary

K partition infermation was found,

Detailed Reports

Report Name Status Generated | Enrors Wamings | Infos
Synthesis Feport

Transkation Ficport

Map Rspart

Flace and Fioute Report

Static Timing Fiepart

Bitgen Report

Figura 10: Entorno de Xilinx ISE
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En la ventana de fuentes, con la pestafia Sources seleccionada, observamos la
lista desplegable etiquetada “Sources for:”, que nos permite seleccionar fuentes
para distintas etapas del proceso de disefio (para sintesis, para simulacion logica,
simulacion después de la colocacién, etc.). Nos situaremos en la selecciéon
Synthesis/Implementation, y dentro del conjunto de modulos para sintesis,
seleccionamos el esquemético que queremos editar (por ejemplo, pruebal), y
con el boton derecho del raton pulsamos Open. El espacio de trabajo (o ventana
de edicion) cambia entonces a un editor de esquematicos que presenta la Figura
11.

[E= Xilinx - ISE - C:\hlocal\practical\practica.ise - [pruebat.sch]

File Edit Wiew Project Source Process Add Tooks Window Help []r=i]
DPEHS LixRX oo APHHM B (A BB MDA vi @
FE YA OO P -F/2-5 VO O0ARBIML P Al
Si a3 X
Sources for:| Syrthesis/Implementation v
=] practicat
= £ xc351000-51256
[ oy ivisor - divisor_arch (divisor. vid)
[2] pruebal (prueba.sch)

13 Sources |l Snapshal:| [P Libraries| = Symbols

Select Options

Wwhen pau click on a branch
@ Select the entire branch

O Select the line segment

“wihen pau move an abject

< >
2f! Processes | £ Options

= Design Sunmary | [8] pruebal sch
L - v £ 0 . - g

Figura 11: Entrada de esquematicos

En la ventana de fuentes nos aparece una nueva pestafia Symbols, y al
seleccionarla se muestra la biblioteca de modulos predisefiados que podemos
utilizar en nuestro disefio (Figura 12). En la ventana para edicién dibujaremos
nuestro disefo.
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E Xilinx - 1SE - C:i\prog’\ISE\practical ypractical ise - [pruebal.sch*] ;lglil
Ble Edit Wiew Project Source Process Add Tools Window Help =13 x|
EEE B EEETS R R =Y =%
EFE[ERnERoD(x [ vtErz[2F5[ N0 / OA[BS &y ][44~ =

S|

Categories
10_Latch B
Latch
Logic
LuT

L

Symbals (that begin with im)

inv16
imsd
ims8

VY

Symbol Mame Filter
Iinv

Orientation
I Fotate 0 j

Symbaol Info |

=F4 Source]m Snapshw] Iy L\brarielﬁ Symbo

L

Select Options

\ =

I =

< | B
Opt

&f Processes J & Opime I 1 Design Summary | [ pruebal sch*

= =

Started : "Launching Design Summary". _I

Started : "Launching Schematic Editor to edit pruebal.sch™. _l;l
13

< |

Cansole |°Ermrs I 1 Wiarnings I_ﬂ'ﬁ:\ Shell I 14 Find in Files I

\ [[100832]

Figura 12: Entrada de esquematicos con menu de simbolos

Para elegir los simbolos utilizamos la pestafia Symbols de la ventana de fuentes,
y a través del menu Categories y el mend Symbols iremos seleccionando los
elementos de nuestro disefio y colocandolos en la ventana de edicién. En el
ejemplo vemos que estamos generando un esquematico que incluye distintos
tipos de puertas basicas (panel de la derecha en la Figura 12) a partir de los
simbolos de la categoria Logic (panel de la izquierda en la Figura 12): inversor
(inv), and de 2 entradas (and2), or de 2 entradas (or2) y nand de 2 entradas
(nand?2).

Para realizar las conexiones utilizaremos el boton AddWire 11 que se
encuentra en la barra de herramientas.
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Una vez realizadas las conexiones el disefio debe quedar como se muestra en la
Figura 13.

E Xilinx - 1SE - C:'prog’\ISE\practical ypractical ise - [pruebal.sch*] -0 LI
File Edit Wiew Project Source Process Add Tools Window Help =18 %]
IDPELlsebx @a[RALX X AF A% E o]~ wellw w] =S

ez | exaadoolx[veyr=[zFs[ "0 / 0A[RS &7 [A AR =

[
Categories
10_Latch -]
Latch
Logic — —r—{
LuUT -
S 5 (that begin with and?) :E.>_"
S o]
andzbl
andZb? — .
Symbol Mame Filter :E}—'
IandZ =
Orientation
IRotateD j
Symbol Info |
g SDurcst Snapshw] n} L\hrarlslﬁ Symbo
[
I Select Options i
[e h
< | ’
L Riocesse J & Opites I w Design Summary | [B] pruebal sch*

] -
Started : "Launching Design Summary"”. _I
Started : "Launching Schematic Editor to edit pruebal.sch™. _l;l

4 | | »

Cansole |°Ermrs I 1 Wfarnings I_@Tc\ Shell I 16 Find in Files I

\ [[108:32] ,

Figura 13: Puertas légicas e interconexiones sin Buffers de E/S

En el caso que vayamos a implementar el disefo, nos falta anadir los IBUF y

OBUF (categoria 10, simbolos ibuff y obuf), y los pines de entrada-salida con el

botén 55 que se encuentra también en la barra de herramientas. En este caso

las entradas las nombraremos como A y B, y las salidas recibirdn el nombre
salida_not, salida_and?2, salida_or2 y salida_nand2.

El resultado es el que se muestra en la Figura 14. Una vez terminado es
aconsejable salvar el disefio.
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ﬁxilinx - I8E - C:\prog“ ISE\practical \practical.ise - [pruebal.sch] ;Iglil
[ Ele Edlit Wiew Project Source Process Add Tools Window Help =18 x|
c2EFdLlsnexwa AP X X B R[[H]2E o 0|)A 2 ]0h ] el
6 7 @[ @HAAA[OD|[r [ T =[oF8[ 0 / O0ARI ][] A LA

=

Categories
Uecader

Flip_Flop
General

10
I0_FlipFlop
10_Latch
Latch

L

L

[

Symbaols

ibuflé
ibufq
ibufg
ibufds
ihufg
ihufgds

iobuf LI

Symbol Name Filter

Orientation
I Ratate 0 j

Symboal Info |

B3 Source E Snapshi Eubrarix L Symbo = Design Summary | [ prushal sch

E] =

Start DRC ...

No error or warning is detected
| | »

5] Console | @Enors | ¢\ wamings | @ Tcl Shell | g Find in Files |

I [[s80,32]

Figura 14: Puertas y entradas con Buffers de E/S

1.5Creacion del NETLIST

Para que el fichero pueda ser simulado se debe generar el listado de
conexiones (Netlist) del mismo. Verificamos que el esquematico no contiene
errores légicos seleccionando Tools>Check Schematic. La ventana de
mensajes deberia informar que no se detectan errores o advertencias. Si la
ventana de mensajes nos informa de alguna advertencia o error, se debe

remediar antes de continuar

Llegado a este punto estamos en disposicion de pasar a simular el circuito,
para esta fase se requiere (aparte del ISE) un programa adicional de simulacion
l6gica. En este laboratorio utilizaremos el programa de simulacion Mentor
Modelsim. El acceso a dicho programa se encuentra plenamente integrado en el
interfaz gréfico del ISE, por lo que puede ser invocado sin cambiar de entorno,

COmo veremos a continuacion.
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2 Simulacion del disefno

En primer lugar, en la ventana de fuentes seleccionamos la pestafia Sources y la
opcion Behavioral Simulation en la lista desplegable “Sources for:”, de forma
gue se visualicen las fuentes de nuestro proyecto que se pueden simular, y
elegimos aquella que queremos simular (en nuestro caso pruebal.sch). Antes de
realizar la simulacion, es necesario generar un testbench con las entradas con
gue queremos estimular a nuestro disefio para comprobar que funciona. Es decir,
la simulacion solo va a realizarse para el conjunto de estimulos que coloquemos
en el testbench. Para circuitos simples, el conjunto de estimulos puede ser el
total de todas las posibles entradas de un disefio, pero para médulos muy
complejos puede interesarnos realizar la simulacién sélo para un conjunto de
posibles entradas.

2.1Generacion de un fichero de estimulos (Testbench)

Para generar el conjunto de estimulos, seleccionamos en el menu superior:
Project>New Source y en la ventana que nos aparece (Figura 15)
seleccionamos:

Tipo de fuente: Test Bench Waveform, y damos un nombre al fichero donde
vamos a crearlo, por ejemplo testl, como se muestra en la Figura 15.

ES New Source Wizard - Select Source Type

g EMM File

q IP [Caoregen & Architecture YWizard)

Ea| MEM File

£| Schematic

"t.| Implementation Canstraints File

State Diagram File name:

test]

v | Werilag Module Location:

Werlog Test Fisture .
YHOL Maodule C:\hlocalpractical E]

WHDL Library
[#]%HDL Package
] WHOL Test Bench

Add to project

< Back [ Next » l ’ Cancel

Figura 15: Generacion de un testbench
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Pulsamos Next y en la siguiente ventana (Figura 16) nos piden el nombre de la
fuente con la cual queremos asociar el testbench. En nuestro ejemplo
seleccionaremos pruebal.

[E= New Source Wizard - Associate Source

‘SBIBCI a source with which to associate the new source. |

divisor

l < Back ] [ Mext > ] [ Cancel

Figura 16: Fuente asociada al Testbench

Pulsamos Next y Finish.

A continuacidén nos aparece una ventana con datos temporales para la simulacion
del disefio (Figura 17), como por ejemplo la forma del reloj, el tiempo de
simulacion, etc. En este ejemplo, como se trata de un circuito combinacional,
seleccionaremos la opcion Combinatorial y dejaremos el resto de opciones con
su valor por defecto. Para continuar pulsaremos Finish.

= Initial Timing and Clock Wizard - Initialize Timing

Assign Check Assign
Inputs Qutputs Inputs
Wait To [ Whait To

|*= Check -L- Assign
v

Clock Information

) Sirnghe Clack

) Multgse Clocks

(=) Combinatorial for inreimal clock)

Cambinatonial Timing Infeemation

Inputs are acsigned. outputs e decoded then

checked A delay between inpifs and cutputs avoids

ssigrenent/checking conficts.

Chech Ouipets (S0 | ne Alter Inguts sn Assigned
Azsign Inputs |50 ns Adter Outputs are Checkied

Globsod Swgrals

Irbial Lenglh of Test Benche 1000 "
[E] GSR (FFGA)
Time Scale: | re -
High fios Irstiat | 100 ns
o]

Figura 17: Datos temporales de la simulacion
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En la siguiente ventana (Figura 18), nos aparece el valor que se ha asignado de
forma automética, de todas las entradas y salidas de nuestro circuito.

B Xitina - ISE - C:\progASP\practicat \practicat.iss - [test1.1hw*]

[ P [t View Project Source Process TestBench Smylstion Wndow bl LI
OPHG SiDBX Ba Q"F2KXE @ A RSO LR NA )7V
0 B8R QO e A4 D0y w e
Suees i Seetiord S ik = BncTime: 50 150 250 350 450 S50 650 10 gs0 g
s 5 i 5 5 i ;s 5
Joaceat bl L08R ey o
O eI 0050255 s
[ pramtiat [prusbial schy ans =
W salida_arad [}
Misalida_NANDZ 0
M salids_MOT o
M salida_0R2 o
St Sowces | Sracaboty | [ Liearies | o Symboly
1
- - ¥l S |
RIS B Hiwity ) S [ pousbat.sch | o Doign Summary | [ testh o
Clck b Mavigate b the webh For an ansuwes Frcord on this messagn T —

Figura 18: Formas de onda iniciales del TestBench

Es necesario modificar el conjunto de estimulos que aparece inicialmente, de la
forma que consideremos mas adecuada, para probar el maximo numero de
combinaciones de entrada posibles. Simplemente pulsando en las
correspondientes formas de onda, donde queramos cambiar su valor, se
modifican automaticamente. Un posible Testbench final que cubre las 4 posibles
combinaciones de la sefiales de entrada es el que se muestra en la Figura 19.
Una vez terminado, salvar las formas de onda.
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B Kilinx - 51 - C\progMSHipracticallpractical bse - [{es11.1bw] o

) Bl BB Yew Pk Souce Briwess DestBench Smyston Wedew Hep EE

DRPEA? G chBX 9o A FLPKKN B ARSI A e ==V
| @ TCRTEC I DO ey fACH DNy B0 ¥m v

End Time:
1000 ns I

Mestissanpz 0
Mzalisa HanD: 0
M saiiza_NoT (]
M zalisa_0R? ]

¢
B Processes | (] Mierarchy - teat it

il 3kl ¥

B bl sk | Do Sommnary | [ tmati e

Figura 19: Formas de onda finales del TestBench

Se puede observar que en la ventana de fuentes, con la seleccién Behavioral
Simulation, ha aparecido la nueva fuente testl.tbw, en cuyo interior se encuentra
nuestro esquematico pruebal.sch. EI modulo testl.tbw es realmente el que
podemos simular, puesto que tiene definidas las entradas. Si seleccionamos este
moédulo, y en la ventana de procesos seleccionamos la pestafia Process,
veremos que entre los procesos asociados a la fuente testl.tbw aparece el de
simulacion.

2.1.1 Simulacion de estimulos complejos de sefiales

Una manera alternativa de definir los estimulos de una cierta sefial es pulsando
con el botén derecho sobre su forma de onda y seleccionar entonces la opcion de
Set Value, lo que produce la aparicién del cuadro de didlogo que se muestra en
la Figura 20.

ES|set Value Fz|

Enter the desired binary value:

[ Pattern “Wizard ]

[ ak l [ Cancel ] l Help ]

Figura 20: Dialogo para fijar valores de simulacidn para variables
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Donde se puede seleccionar la opcion Pattern Wizard, que permite definir como
varian las sefiales de entrada o tipo de patron de estimulos (Pattern Type), la
duracién del estimulo en ciclos (Number of cycles), y con qué parametros se
debe aplicar el patron (Pattern Parameters), segun se muestra en la Figura 21 .

ES pattern Wizard E|

General Pattern [nformation

Pattem Type: | Mumber of Cycles; |8

R adix
(=) Binary () Decimal ) Hexadecimal

Pattern Parameters

Iriitial W alue: Pulze Value:
D 1 7
Iritial Delay: : I Mé I : Pulze Width:

1 1

| ok || cacel [ Hep |

Figura 21: Formas de onda finales del TestBench

De las opciones que aparecen en la ventana, sélo utilizaremos inicialmente el
patron de tipo Pulsos (Pulse). Este patron nos permite darle un valor inicial a
cada sefal (Initial Value), el retardo que dicho valor inicial se debe mantener
(Initial Value), e indicar cual sera el valor del pulso (Pulse Value) y el nimero de
ciclos de reloj que quiere mantenerse la sefial a dicho valor (Pulse Width). De
este modo, para crear un estimulo que dure 8 ciclos desde la posicién actual de
simulacién, para una sefal que cambie su valor cada ciclo de reloj y tenga como
valor inicial un 0 légico, debemos definir la sefial como se muestra en la figura. De
manera similar, si se quisiera generar una sefial que cambie su valor I6gico, basta
con fijar su retardo inicial y su ancho de pulso a 2, y asi sucesivamente con
potencias de dos para las sefiales con mayor peso.
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2.2Simulacién de un Testbench

En la ventana de fuentes, seleccionamos la pestafia Sources, y dentro de las
fuentes la correspondiente al Testbench (testl.tbw). En la ventana de procesos
seleccionamos la pestafia Process, para que nos aparezcan todos los procesos
asociados a la fuente testl (segun se muestra en la Figura 22). Entonces
mandamos ejecutar la simulacién pulsando dos veces sobre ModelSim
Simulator->Simulate Behavioral Model, o bien seleccionado ModelSim
Simulator>Simulate Behavioral Model y pulsando el boton derecho vy
seleccionando Run.

IS Xilinx - ISE - C:\prog\ISE\practical \practical.ise - [test1.thw]
File Edit View Project Source Process Test Bench Simulation Window Help (=[5 [X§
DPEHF LiBEX ©e QAL XXA @ AmBOD:IAR MK v: @
EEE SN QD LK BN o ¥
[ Sources ] ot 4]
Soutces for R = End Time: 50 150 250 350 450 550 850 750 850 a50
E]practical 1000 ns (. | | T
= €72 ve3s1 00051256 ans 1
=[] test? (st tow) ane ;
[2]UUT - pruebat (pruebal.sch] I [
M salida_AND2 [i}
I salida_NANDZ ]
AN salida_NOT ]
AN salida_OR2 i]
S Souces | Snapshots | [P Libraries | =3 Symbols
[P
Processes for: test]
[ Add Existing Source
[ Create New Source
[E]  View Generated Test Bench &s HOL
[ 4dd TestBench Ta Project
=% Modelsim Simulator
=M Simulate Behavioral Model
M Generate Sef-Checking Test Bench
< BRI
P i =
B4 Pracasses | [ Hierarohy - teotltow 1) pruebat sch | & Desion Summary | [ testt tow
Time: --

Figura 22: Inicio de la simulacion utilizando ModelSim

El resultado de la simulacion se presenta en la Figura 23. En algunas ocasiones
hay que cerrar una ventana que aparece en el workspace, justo antes de la
visualizacién de la simulacién. Es necesario centrar la ventana de la simulacién y
ajustar el zoom para observar correctamente el resultado.
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[¥] ModelSim SE PLUS 6.2a

File Edit Wiew Compie Simulate Add Wave Tools Layoub dow  Help
IZHS I RRD2 ME %] SERE] 4 «= | wnd BT 7]
Y TR I S IR

‘wiorkspace HaAx T wave - defaul

7]instance [Design unit [ Design unit type | isibilt,
test 1 Sture:

f. uut prusballbe... Architecture +acc="
& line_G6 testiftestbe... Process +acc=
Bl vital_timing vital_timing ~ Package +ano=
B std_logic_unsigned std_logic_un... Package +30C="
B std_logic_arith std_logic_arith Package +acc="
B std_logic_textio std_logic_tex . Package +acc=
H testio textio Package +ace=
B numeric_std numeric_std  Package +acc="
B vcomponents woomponents Package +acc="
Bl std_logic_1164 std_logic_1... Package +ace=
B standard standard Package +acc="

I

Cursor 1 I

I —| 2 | g JT | i =] |

[ o | i [ 3 i | 2 womones | Aol 11 ] weve b

Transcript HA

B main_pane.signals.interior. s -

VI 2 j

=4 Transcript EE
[Nowe: 1 us Delta: 1 [sim:testl - Limited Visibility Region [0ps to 1075256 ps A

Figura 23: Resultado de la simulacién del TestBench

Si consideramos que es mejor cambiar el valor de los estimulos de entrada, habra
que repetir el proceso de edicion del testbench. Si no esta abierto el fichero con
las formas de ondas, primero pinchamos sobre la fuente correspondiente
(testl.tbw) y con el boton derecho del ratén pulsar Open. Una vez abierto, se
modifican las formas de onda pinchando sobre ellas como se ha explicado en el
apartado 2.1 y luego se vuelve a ejecutar la simulacién seleccionando, en la

ventana de procesos, Modelsim o algun otro simulador alternativo que se
encuentre instalado.
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PRACTICA 1: Disefio de un comparador.

OBJETIVO: Disefio completo de un circuito combinacional usando puertas
I6gicas.

ESPECIFICACION:

Alto nivel:
Entradas: X Xe{0,1,2 3}
Y Ye{0,12 3}
Salida: S Se{0,1,2}
Funcioén de alto nivel: 0si X=Y
1si X<Y
2si X>Y

PASOS A SEGUIR:
1.- Codificar en binario puro las entradas y las salidas del sistema.

2.-Obtener las tablas de verdad del comportamiento del circuito en términos de
la codificacion realizada en 1.

3.- Especificar el circuito usando expresiones canoénicas.

4.-Simplificar las expresiones candénicas usando diagramas de Karnaugh.

5.-Disefiar el circuito usando dos niveles de puertas AND/OR (simbolos andX y
orX de la libreria de simbolos del ISE, sustituyendo la ‘X’ de los nhombres
de los simbolos por el nimero de entradas de cada puerta deseada)

6.- Capturar y simular el circuito del punto 5.

7.-Convertir el circuito del punto 5 en dos niveles de puertas NAND (simbolos
nandX de la libreria de simbolos del ISE).

8.- Captura y simulacién del circuito del punto 7.
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IMPLEMENTACION:

Nombres de los diferentes puertos:

e Vector X: X0y X1 (en mayusculas).
e Vector Y: YOy Y1 (en mayusculas).
e Vector S: SOy S1 (en mayusculas).
Nombre de los archivos:

e Paso 6: Prll.sch
e Paso 8: Pr12.sch

NOCIONES TEORICAS:

Mapas de Karnaugh.
Cadificacion en binario.

NAND.

1 TestBench exhaustivos en Xilinx ISE

Formas candnicas de las expresiones de conmutacion.

Equivalencia de dos niveles de puertas AND - OR y dos niveles de puertas

En la simulacién del esquematico disefiado en esta practica debemos hacer
una prueba exhaustiva de todas las posibles configuraciones de las entradas
(tabla de verdad) y verificar que las salidas toman el valor esperado. Para ello
debemos forzar estimulos periddicos en las sefales de entrada, empezando
por la sefial menos significativa, continuamos con las siguientes doblando el
periodo de la sefial anterior, y asi sucesivamente hasta la mas significativa. Este
tipo de estimulos se pueden introducir segun las indicaciones de la Seccion

2.1.1.

Las formas de onda que deben fijarse en el TestBench de esta practica
mediante la definicién de patrones se muestran en la Figura 24, donde podemos
observar que aparecen ordenadamente todos los casos de la tabla de verdad.
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Figura 24: TestBench de la simulacion de la tabla de verdad

Las ondas resultantes de esta simulacion en Modelsim se muestran en la
Figura 25, donde podemos observar que aparecen ordenadamente todos los
casos de la tabla de verdad.

7] Modalsim SE PLUS 6.2a
Fie Edt Yew Comole Smdste Add Wave Took Layod Window Helr

[DeEd (a0 Al %] SR+« Bo-uuH HP e
A n mmd my & AQQE|
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M otd_bog_urviigned
W sid_logic_aity

W oot
o e
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M e

18| i
‘\uwgﬂm[ A

Transcipt
T
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IR Tranucrt | fil
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Figura 25: Resultados de la simulacién en Modelsim del comparador
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PRACTICA 2: Disefio de un sumador.

OBJETIVO: Disefio modular y jerarquico de circuitos combinacionales.

ESPECIFICACION:
Alto nivel:

Disefio de un sumador de nimeros positivos, codificados en binario puro
de 4 bits; poseera una linea de C;, (para el acarreo de entrada) y otra de Cy
(para el acarreo de salida).

Binaria:

Entradas: X,Y €{0,1} / X, Y en binario puro

Salidas: S €{0,1} / Sen binario puro
Cout € { 0, 1 }

Funcion:
S (X+Y+ Cj, ) mod 16

Cout 1 si X+Y+Cj, > 15

0 en caso contrario
PASOS A SEGUIR:
1.-Implementar el circuito sumador de un bit usando puertas NAND y XOR
(simbolos nandX y xorX de la libreria de simbolos del ISE, sustituyendo la
‘X" de los nombres de los simbolos por el nimero de entradas de cada
puerta deseada)).

2.-Captura y simulacién del sumador de un bit.

3.-Interconectar los cuatro sumadores de un bit entre si y con puertos externos.
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4.- Capturar y simular el circuito completo.
5.-Disefiar jerarquicamente en dos niveles el sumador completo.

6.- Capturar el disefio jerarquico.

IMPLEMENTACION:

Nombres de los diferentes puertos:

Entradas del sumador de un bit: X, Y y Ci.

Salida del sumador de un bit: Z y Co.

Vectores de entrada del sumador de 4 bits X=(X0,X1,X2,X3), Y=(Y0,Y1,Y2,Y3).
Vector de salida del sumador de 4 bits S=(S0,S1,S2,S3).

Entrada y salida de acarreo del sumador de 4 bits: Cin y Cout.

Nombre de los archivos:

Paso 2: Pr21.SCH.
Paso 4: Pr22.SCH.
Paso 6: Pr23.SCH.

1 Nociones tedricas

El elemento de suma mas sencillo es el llamado semisumador, que tiene
dos entradas, los dos bits a sumar, y dos salidas, el bit de suma y el bit de
acarreo. A partir de este médulo podemos desarrollar el sumador completo de
un bit, que tiene tres entradas: los dos bits a sumar y un acarreo de entrada, y
dos salidas: el bit de sumay el bit de acarreo de salida.

La forma méas sencilla de implementar un sumador de nimeros codificados
en binario con n bits es mediante el "encadenamiento” de n sumadores
completos de un bit. Este método se corresponde con el método de suma "a
mano" de dos ndameros en binario. Los sumadores se disponen en bateria,
sumando cada uno de ellos cada par bits de igual peso de las entradas, y se
conectan los bits de acarreo de forma que el acarreo de salida del sumador de
peso i sea el acarreo de entrada del sumador de peso i+1. Finalmente, el
acarreo de entrada del sumador de peso 0 se pone al valor l6gico 0, y el acarreo
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de salida del sumador de mayor peso (n-1) constituye el acarreo de salida de la
suma total.

2 Nociones de Xilinx ISE
2.1Disefio jerarquico en Xilinx ISE

Para realizar un disefio jerarquico necesitamos crear un simbolo a partir de un
disefo ya existente. EI simbolo consistira en un nuevo componente donde el
usuario solo vera un bloque con el mismo namero de entradas y de salidas que el
esquema original, que englobara a éste y realizara su misma funcion. Este simbolo
gue se crea, pasa a formar parte de la libreria de componentes del proyecto, y
podré utilizarse como un dispositivo mas. Como ejemplo, vamos a generar un
simbolo llamado pruebal que representa el conjunto de puertas l6gicas basicas de
la practica O (pruebal.sch). Para crearlo, una vez terminado el disefio vamos a la
ventana de fuentes (vista Synthesis/Implementation) y seleccionamos el fichero
fuente que contiene el conjunto de puertas légicas. En la ventana de procesos
seleccionamos la pestafia Process, y dentro de Design Utilities pulsamos dos
veces sobre Create Schematic Symbol, seglin se muestra en la Figura 26.

I xilin - ISE - Ci\progMSEpractical \practical ise - [priebat sch

Bl o Edt Yiow Promel Souce Process &K Toch Windw Heb [ =1
DAHEHS G S0GEX 20 QAKX E B A0 ME w2V B0 TR T
OOk Ues )% 2-5 YO/ OANGA 7 Aanm

Sources bor | SynihesaAme | Numbes of | LUT: 3
HET  Man  Proseny

Fonscical
O 100058255

s
[0)i iypruebat Ipsusba.zch] ot

¢ s

(W] View HOL Instirsistion: Termglae -
4 »
B Pocasies | 53 Opkern

X Dengn Summary | [B] pshial sk
Started ! "Launching Schematie Editar to edit prosbal.sch”. <
Start DEC ...
Mo srear of warming is detactsd
= »
U Corece | @ Dvos |y Wamngs | @ TdSked | 3 Findin Fikes

[+, 100]

Figura 26: Generacion de un simbolo asociado a un esquematico
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Para ver que la operacién se ha realizado de forma satisfactoria, y que tenemos
el simbolo disponible en la libreria, se accede a la ventana de fuentes y
seleccionamos la pestafia Symbol. En la categoria c:/hlocal/practical aparece el
nuevo simbolo pruebal, como se muestra en la Figura 27.

E Xilinx - ISE - C:yhlocal\practical \practical .ise - [pruebal .sch*] ;Iglil
[ File Edit Wiew Project Source Process Add Tools Window Help ===
EEEEIE PR EEE S R B EEEEEEE =
lfpa[a@xxxaledrfjverrz=zFa~o / 0ABan[/][4 s a =

E|

Categories

<—All Symbols—> -
<C/hlocalfpractical > LI
Symbols

W

Symbol Name Filter

Orientation
I Raotate 0 j

Symbol Info |

[=h4 Snur:slﬁg Snapshwl [y Lihramlﬁ Symbo
S|

No flow available.

L4
Frocesses Options |
i 2 = Design Summary | [6] pruehal sch*

X -
Process "Create Schematic Symbol" completed successfully

4 | 3

|£] Console | @ Errars I 1 Wiarmings IﬂTc\SheH I 1 Find in Files I

\ [[460-16]

Figura 27: Esquematico del nuevo simbolo pruebal

De este modo, el modulo pruebal puede afiadirse a un nuevo esquematico (por
ejemplo, jerarguico.sch) como cualquier simbolo de las librerias del ISE. Tras
afiadir el médulo pruebal al nuevo esquematico, al seleccionar la pestafa
Sources, vemos que el huevo moédulo esta dentro del esquemaético jerarquico.sch
al ser un disefio jerarquico, como se muestra en la Figura 28.
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Figura 28: Disefio jerarquico de esquematicos

La realizacion de simbolos es una herramienta muy util a la hora de disefar
circuitos mas complicados y que ademas tengan partes que se repitan. Facilita el
disefio jerarquico y estructurado, permitiendo una mayor claridad a la hora de
presentar un circuito y entender su funcionamiento.

2.2Buses
Cuando en un disefio utilizamos sefiales de mas de un bit, es conveniente emplear
buses. Lo primero que hay que hacer es crear los terminales de los buses. Para
ello, al crear los pines de entrada-salida con el botén & de la barra de

herramientas, nos aparecera una ventana como la que se muestra en la Figura 29,
donde tendremos que indicar el nhombre, el tipo de terminal y el nimero de bits del
bus, segun el formato NOMBRE(NUM-BITS).
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Figura 29: Pantalla de definicion de propiedades del bus

Como ultimo paso, hay que renombrar los cables de conexion de las entradas de
las puertas correspondientes con los nombres de los componentes del bus que se
desean. Para ello, pulsamos con el boton derecho sobre el cable que queramos
renombrar y elegimos la opcion de renombrarlo (Rename Selected Net), de modo
que nos aparece una ventana tal y como se muestra en la Figura 30.

EE Rename Net &|

) Rename the Branch's Met

{(*) Fiename the Branch

T

Dizplay the Met Mame on the Clicked Paint(If It s Mot
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| ok ][ cencel |[ Hep |

Figura 30: Pantalla para renombrar un cable de conexion

Laboratorio de Fundamentos de computadores
31



Facultad de Informética Curso 2009/10
Universidad Complutense de Madrid

Después soélo hay que incluir el nombre del componente del bus que queramos
utilizar como cable de conexion para dicha puerta segun el formato NOMBRE(BIT)
(0 NOMBRE(BIT-INICIO:BIT-FIN) en el caso de ser un rango de bits). Como
ejemplo, el resultado final con un bus de entrada para un esquematico que contiene
una puerta AND de 4 entradas quedaria como aparece en la Figura 31.

ES [ Xitin - ISE - C:\proglISE\practicallpractical.ise - [and4bus.sch] EH’E\E\
Fle Edt View Project Source Process Add Tooks Window Help B X
DPEHG LiGREX wa QISP XKP B AiRE DDA RiME  “MiCIEEE BUALN
QO in] Ve - |R-83 YO OA RIS A |V AL

|Sowces x| ~
ISW'CM e— Q[ g Cnimiiiiiiianoan
(“jpracl\cﬂ :
= £ #c3s1000-51t255

[B]efh andabus (anddbus sch)

< >

a1 Sources | Snapshots | Py Libvaries | 2 Symbels ¥ Desgn Sunmery | [B)pruebet sch | [B) endus s

start DRC ...
No error or warning is detected

~
>

& Coneole | @ Enos |\ Wanings | (@ TolShell | (g Findiin Fles

[1008, 1356]

Figura 31: Uso de un bus de entrada para una puerta and4
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PRACTICA 3: Disefio de un generador de
secuencia ascendente / descendente.

OBJETIVO: Disefio completo de un circuito secuencial usando biestables.

ESPECIFICACION:
Alto nivel:
Disefio de un circuito secuencial capaz de generar dos secuencias binarias
distintas de valores por su salida S = (s;, Si1, So), en funcién de una entrada de

control C:

Si C=0 lasecuenciaserao, 3,4,2,5,1,6,7,0 ...
Si C =1 lasecuenciasera0,7,6,1,5,2,4,3,0...

En el momento en que varie el valor de la entrada de control el circuito

proseguira contando en la otra secuencia desde el punto en donde se
encontraba.

PASOS A SEGUIR:

1.- Obtener el diagrama de estados del sistema como maquina de Moore.

2.- Codificar los estados con el valor de la salida que les corresponde, de forma
gue la salida sea directamente el estado.

3.-Construir la tabla de transicién de estados del generador de secuencias.

4.-Disefar el sistema usando biestables tipo D disponibles en la libreria de
simbolos (pestafia Symbols) con el nombre fdc.

5.-Captura y simulacién del circuito disefiado en el punto 4.
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6.-

Disefiar un modulo combinacional traductor de codigo que convierta la
secuencia que genera un contador convencional en la que nosotros
deseamos.

Utilizar para la implementacion de la expresion de conmutacion del bit mas
significativo un multiplexor de 8 a 1, que se encuentra en la libreria con el
nombre m8_1le.

Utilizar para la implementacion de la expresion de conmutacion del segundo
bit un decodificador de 3 a 8, que se encuentra en la libreria con el nombre
d3_8e, y las puertas OR (orX) necesarias.

Utilizar para la implementacion de la expresion de conmutacién del bit menos
significativo dos niveles de multiplexores de 4 a 1, que se encuentra en la
libreria con el nombre m4_1le.

7.- Captura y simulacién del circuito combinacional disefiado en el punto anterior.

8.-Opcional: Implementar un contador convencional de 0 a 7. Crear un simbolo

a partir de este contador y otro a partir del traductor de cédigo implementado
con multiplexores. Conectar los dos simbolos. Captura y simulacién del
circuito resultante.

IMPLEMENTACION:

Nombres de los diferentes puertos:

Linea de entrada de control: C.

Vector de salida: S=(S2,51,S0).

Inicializacién a 0 de los biestables (Q=0): CLR=1
Sefial de reloj: CLK

Nombre de los archivos:

Paso 5: Pr31.SCH.
Paso 7: Pr32.SCH.
Paso 8: Pr33.SCH.
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1 Nociones tedricas

1.1 Multiplexores

Un multiplexor de 2" a 1 es un médulo combinacional con 2" entradas de
datos (x), n entradas de control (s), una entrada de capacitacién (E), y una salida
y que verifica la siguiente expresion de conmutacion:

2n—1

y= E-in'mi(sn.l.-.SO)
i=0

Las entradas de control seleccionan cual de las entradas de datos se ofrece
como salida. Por lo tanto, las lineas de control representan la codificacion binaria
de la entrada de datos a seleccionar. Por ejemplo, en un multiplexor de 16 a 1
(16 lineas de datos x5 a Xg, cuatro lineas de control s; a Sg, y una salida y), la
asignacion de las lineas de control al vector 0101 selecciona como salida la
linea de datos Xs.

La idea de la sintesis usando multiplexores consiste en utilizar las variables
de entrada de la funcién a implementar como entradas de control del multiplexor,
y fijar cada entrada de datos del multiplexor al valor logico asociado al
mintérmino correspondiente.

1.2Descodificadores

Un descodificador de n a 2", es un médulo combinacional con n entradas de
datos (x), una entrada de capacitacion (E), y 2" salidas (y) que verifican la
siguiente expresion de conmutacion:

Y= E-m(Xp1...Xo0)

Las entradas de datos representa la codificacion en binario del nUmero de la
linea de salida que se activa, es decir, que toma el valor loégico 1, mientras que
el resto de salidas permanecen a nivel l6gico 0. Por ejemplo, en un
descodificador de 4 a 16 (4 lineas de entrada de datos xs; a Xq, y 16 lineas de
salida y5 a Yo), la asignacion de las entradas al vector 1001 activara la linea yo,
permaneciendo el resto de lineas inactivas.
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Para implementar funciones de conmutacibn con descodificadores
utilizaremos las variables de entrada de la funciébn como entradas de datos del
descodificador. Podemos observar que cada linea de salida representa un
mintérmino diferente de la funcién, de este modo la funcion podra
implementarse como suma légica (OR) de sus correspondientes mintérminos.

1.3 Maquinas de estados

Las maquinas de Moore y de Mealy son dos métodos alternativos de modelar
sistemas secuenciales, ofreciendo dos maneras de implementar el mismo
sistema. La diferencia entre ambos radica en el modo que tienen de generar la
salida: mientras que en la maquina de Mealy cualquier cambio que se produzca
en la entrada se manifiesta en la salida, aln cuando no se modifique su estado,
en la de Moore la salida s6lo cambiard cuando el estado de la maquina cambie.

Formalmente podemos expresarlo:

Maquina de Mealy Maquina de Moore
z(t) = H( s(t), x(t) ) z(t) = H(s(t))
s(t+1) = G(s(t), x(1) ) s(t+1) = G(s(t), x(t) )

1.3.1 Biestables D

Un biestable (flip-flop) es un circuito secuencial de dos estados, cuya salida
binaria de un bit corresponde con su estado. Como cualquier sistema secuencial
puede ser especificado usando las funciones de salida y de transicion.

El biestable sincrono tipo D, posee dos entradas binarias de un bit: una de
reloj CLK y una de datos D, asi mismo posee una salida binaria de un bit: Q,
verificando:

Q(Y) D(®) Q(t+1)
0 0 0
0 1 1
1 0 0
1 1 1
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2 Nociones de Xilinx ISE

2.1 BiestableD

El biestable tipo D (fdc en ISE) modelado en la libreria, es un biestable
disparado por flanco de subida (cuando el reloj cambia de 0 a 1, el biestable
muestrea la entrada en ese instante y decide su transicion, el resto de las
modificaciones de la entrada no le afectan).

Este componente, aparte de las entradas sincronas referidas anteriormente,
posee una entrada asincrona (modifica el estado del flip-flop,
independientemente del valor del reloj y de la entrada D): la entrada de clear,
CLR. Con valor 0 no tiene efecto sobre el comportamiento del biestable, pero
cuando toma el valor 1 modifica inmediatamente (asincronamente) el estado del

mismo, poniéndolo a 0. Se puede observar su comportamiento temporal en la
Figura 32 ..
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Figura 32: Simulacién en Modelsim del biestable fdc
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PRACTICA 4: Disefio de un reconocedor de
secuencias.

OBJETIVO: Disefio de un circuito secuencial modelando su comportamiento
como maquinas de Moore y Mealy.
ESPECIFICACION:
Alto nivel:
Disefio de un sistema sincrono que posee una entrada, X, por la que
recibe bits en serie, y una salida binaria, z, que tomara el valor légico 1

cuando los ultimos cuatro bits de entrada formen la secuencia 1101, y O en
otro caso.

PASOS A SEGUIR:
1.-Obtener el diagrama de estados del sistema, suponiendo que es un

reconocedor solapado, como maquina de Moore.

2.-Obtener el diagrama de estados del sistema, suponiendo que es un
reconocedor solapado, como maquina de Mealy.

3.-Obtener las tablas de salida y transicion de estados de los sistemas
especificados en los puntos 2y 3.

4.-Disefiar el sistema especificado en el punto 1 usando biestables tipo JK, que
aparecen en la libreria del ISE con el nombre fjkc.

5.-Captura y simulacién del circuito disefado en el punto 4.
6.- Disefiar el sistema especificado en el punto 2 usando biestables tipo D.

7.- Captura y simulacién del circuito disefiado en el punto 6.
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OTRA IMPLEMENTACION OPCIONAL:

Estudiar la manera de implementar el sistema con un registro de
desplazamiento y un médulo combinacional reconocedor.

Un reqistro de desplazamiento de n bits es un médulo que almacena los n
ultimos bits introducidos. Se implementa facilmente encadenando biestables D.

El médulo_combinacional reconocedor debe verificar que la configuraciéon
almacenada en el registro corresponda con la secuencia a reconocer.

IMPLEMENTACION:

Nombres de los diferentes puertos:

Linea de entrada: X.

Linea de salida: S.

Inicializacion a O de los biestables (Q=0): CLR=1
Sefial de reloj: CLK

Nombre de los archivos:

e Paso 5: Pr41.SCH.

e Paso 7: Pr42.SCH.

¢ Implementacion opcional: Pr43.SCH.

1 Nociones tedricas

1.1Biestable JK

El biestable sincrono tipo JK, posee tres entradas binarias de un bit: una de
reloj CK y dos de datos J y K. Asi mismo, posee una salida binaria de un bit: Q,
verificando:
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Q(t) J(t) K(t) Q(t+1)
0 0 0 0
0 0 1 0
0 1 0 1
0 1 1 1
1 0 0 1
1 0 1 0
1 1 0 1
1 1 1 0
Su tabla de excitacion es:
Q(t) Q(t+1) J(H) K(®)
0 0 0 -
0 1 1 -
1 0 - 1
1 1 - 0

La entrada asincrona de CLEAR funciona de manera analoga a la del biestable

fdc de la practica 3.
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